Demo Script: PowerPivot Demo



	Introduction
	Click Instructions
	Presenter Script

	[image: ][image: ]Click Here

	1. 
	In this demo, you'll learn how you can use the familiar environment of Microsoft Excel 2010 with the PowerPivot add-in to create compelling self-service Business Intelligence solutions.
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	2. 
	Users can share and collaborate using the secure, managed environment of Microsoft SharePoint Server 2010 and Microsoft SQL Server 2008 R2-based management tools.
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	1. On the taskbar, click on Sales Trends.xlsx.
	Richard is a typical analyst in his organization and was just tasked by his VP to gather data. Richard’s VP has a hunch on trends that are happening by product class and region, and wants to compare these trends versus third party industry data. To do this, Richard’s VP wants him to access information that is in the corporate data warehouse as well as external data outside the organization.

How would Richard even start?  Let’s see how he can pull all of this together in a single analytical model to perform some truly remarkable analysis.
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	1. Switch to the PowerPivot tab.
	Let’s start in Excel. You can see this is the familiar user interface with the Fluent Ribbon that was introduced with Office 2007, but it’s got a new tab called PowerPivot.

	[image: ][image: ]Click Here

	2. Click on the PowerPivot window button.
	PowerPivot is an optional add-in for Excel 2010 that allows end-users like Richard to connect to data from multiple sources.  This enables interactive modeling and analysis of massive amounts of data at lightning-fast processing speeds.
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	3. Click the From Database button.
	The Table Import Wizard lets you add business data from your corporate network, your local computer, or ad hoc data sources on the web. You can connect to external data sources directly, or use predefined connection objects such as ODBC to get the data. You can also enter or copy in data from other worksheets, documents, websites, or text files.
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	4. Select From Other Sources.
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	5. Scroll down.
	PowerPivot can connect to any of your existing IT systems or data sources, such as Oracle, IBM DB2, or Terradata.  
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	6. Scroll down.
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	7. Click Cancel.
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	8. Click on the header for the UnitCost column.
	Notice that there are almost 4 million records loaded in this FactSales table.  Despite this large size, Richard is able to easily perform operations on the data, such as sorting a column.
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	9. Select Sort Largest to Smallest.
	PowerPivot is extremely fast, even when sorting millions of rows of data.
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	1. On the taskbar, click on IndustrySalesData.xlsx.
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	2. Click on the upper-left corner of the spreadsheet.
	Remember that Richard needs to compare his company data with industry trends.  With data from his corporate data warehouse already loaded, Richard combines this analysis with external data such as industry sales trends. 
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	3. Select Copy.
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	4. On the taskbar, click on the PowerPivot window for Sales Trends.xlsx.
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	5. Click the To New Table button.
	PowerPivot lets you simply copy and paste data as a new table in the model. 
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	6. Click OK.
	It will even analyze the field names and row data to automatically create relationships between the data outside of the warehouse and existing structured data.
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	1. Click on the PivotTable button.
	Now, all of this data - from the SQL Server data warehouse, and from external data sources - is combined in a single model that can be used to perform analyses that would not previously have been possible from a single analytical tool.  This is something uniquely available in Microsoft Excel and PowerPivot.
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	2. Select Chart and Table (Vertical).
	Now let’s look at the ways Richard can use all this combined data to visualize comparisons that may not have been apparent or easily drawn before. 

Richard is going to use Excel to organize the data in a chart and table that will make it easier to visualize relationships between all these different sources.

Since we’re working in Excel, the functions we use and the actions we take are all familiar. We can create a traditional PivotTable by adding values, rows, and columns.
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	3. Select Existing Worksheet.
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	4. Click OK.
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	5. In the Gemini Task Pane, expand the FactSales node.
	The difference is that the fields we’re drawing from are coming from the model we just created.
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	6. Select SalesAmount.
	We’ll start building this PivotTable by adding Sales Amount.
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	7. Collapse the FactSales node.
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	8. Expand the DimDate node.
	We’ll add some Year columns and then add Product Category and Sub-category rows.
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	9. Click on CalendarYear.
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	10. Click on Column Labels.
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	11. Collapse DimDate.
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	12. Expand DimProductCategory.
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	13. Select ProductCategoryName.
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	14. Expand DimProductSubcategory.
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	15. Select ProductSubcategoryName.
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	1. Select the three year columns.
	And just like that we have a basic PivotChart, pulling data from our model and calculating fields near-instantaneously from millions of rows of data.
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	2. Switch to the Home tab.
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	3. Click on the Conditional Formatting button.
	Let’s add a few visualizations to this report to make it easy for end-users to understand the numbers.

We’ll start with Conditional Formatting, a native feature of Excel. Then add Data bars to the annual numbers for each category. 
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	4. Select Data Bars.
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	5. Select the Green Gradient Fill.
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	1. Switch to the Insert tab.
	Excel 2010 includes new formatting and visualization features that further enhance the way complex data can be visualized to improve understanding and help business users like Richard’s boss make better decisions.
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	2. Click on the Line sparkline type.
	The new Sparklines feature works like a mini-line chart to give you a quick, cell-based historical or series visualization.  This makes it easier to draw comparisons across a number of rows.
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	3. Select the Grand Total column.
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	4. Click OK.
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	1. Click in the PivotChart.
	Richard can take advantage of the new multiple data sources we just added by building a PivotChart that compares internal and external trend data.
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	2. Expand IndustryTrends.
	Let’s begin to add some of these fields to the Chart, starting with Industry Sales. 
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	3. Select Sum_of_IndustrySales.
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	4. Expand ProductClass.
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	5. Click on ClassName.
	Now when we add this Product Class Name field, we get an alert at the top of the Task Pane.
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	6. Click on Slicers Vertical.
	

	[image: ][image: ]Click Here

	7. Click the Create button.
	Underlying the model are the relationships between the tables and fields for all the data that’s been imported. The PowerPivot add-in to Excel is smart enough to alert you when relationships are needed, and even detect relationships between some data automatically. 
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	8. Click Close.
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	9. Expand FactSales.
	We see the same thing when we add the Contoso Sales numbers.  A new relationship is created.
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	10. Select SalesAmount.
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	11. Click the Create button.
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	12. Click Close.
	

	[image: ][image: ]Click Here

	13. Collapse FactSales.
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	14. Expand DimDate.
	Let’s add the Year value to the chart to see a 3-year view. 
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	15. Click on CalendarYear.
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	16. Click on Axis Fields.
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	17. Collapse DimDate.
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	1. Switch to the File tab.
	This worksheet is now a fully interactive Business Intelligence analysis tool that can be shared with other people.  These users can easily sort and filter the data with just a web browser using SharePoint.  Richard, a typical analyst, was able to use his familiar environment within Excel to pull together this unique view of the data.
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	2. Click on Share.
	To share the analysis with other employees, Richard can post this over the web into Microsoft SharePoint Server.  It’s as simple as doing a “Save As” function.  
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	3. Click on Save to SharePoint.
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	4. In the Recent Locations, click on PowerPivot Gallery.
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	5. Click in the File Name field.
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	6. Click Save.
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	1. Click the right arrow.
	Once published to SharePoint, any end user can see the analysis over the web.  They can browse for the file through the new carousel view which allows users to interactively visualize thumbnails of the analysis they want to see.
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	2. Click on the workbook preview image.
	After finding the newly-published Industry Trends workbook, we can now open this from within our web browser
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	3. In the ClassName slicer, click on Economy.
	After opening this file, users can interact with it, and select slicers to filter the data.
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	4. Open the Favorites menu.
	With the analysis secured in the SharePoint environment, IT can now manage, administer and apply the appropriate permissions to the Excel file.
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	5. Select PowerPivot Management Dashboard.
	You may have noticed that the PowerPivot workbook that Richard created earlier was just one of several such workbooks that have been created by users at Contoso. The job of managing these self-service BI solutions falls to Contoso’s IT administrators.
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	1. Open the View menu.
	In the management console for SharePoint Server 2010, IT can monitor the performance of PowerPivot applications.  In this case, you can see a spike here in the middle of Query Response Times indicating something may need to be done with the allocation of resources
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	2. Select Average Instance CPU.
	You also can manage and monitor other things like Average Instance CPU.
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	3. Click the Play button.
	In the management console, you can also see a time-series visualization that shows workbook activity over time. We actually can play the timeline to see changes in how certain workbooks are being used and how many users are accessing them. 
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	4. 
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	5. 
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	6. 
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	7. 
	This visualization is showing us that a particular workbook may need extra attention in terms of resourcing.
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	8. 
	Within SharePoint, this PowerPivot Management Dashboard allows IT to manage Excel workbooks in a central place.  The Dashboard tracks what workbooks are being stored in the system, what resources they require, and how many users are using them.  Armed with this information, IT can make informed decisions about how to allocate resources to support the needs of the business.
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	1. 
	As you’ve seen in this demonstration, Microsoft empowers users to work with large amounts of information within the familiar Excel environment.  Users can easily organize data from multiple sources and perform deeper kinds of analyses that can be shared throughout the organization in a managed IT environment.

For more information on Microsoft Business Intelligence solutions, contact your Microsoft Representative.
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